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Massachusetts Department of Transportation
Guide for Submitting a Research Report

Introduction

The Massachusetts Department of Transportation (MassDOT) Research Program provides
for research to be funded with Federal Highway Administration (FHWA) State Planning and
Research (SPR) funds.
The instructions in this Guide are addressed to Principal Investigators (PIs) whose
responsibility is to finalize and submit draft final research reports under the MassDOT
Research Program. Please remember that draft final reports must be submitted three months
(90 days) prior to the end of the contract. Please plan accordingly.
Because these instructions are updated intermittently, you should review all information in
this Guide before submitting reports or other deliverables to MassDOT. This guide covers the
required organization and formatting of final reports for publication, the requirements for
compliance with Section 508 accessibility standards, and instructions for submittal. The
Guide refers to the Sample Research Report (see Appendix) for further clarity.
Reports that do not follow this Guide will not be accepted as final deliverables. In the
event that you believe a change in format or organization would offer a more effective
presentation for the research material, please contact the Manager of Research and the
Project Champion as soon as possible in writing, requesting permission for a change. Any
change must be authorized in writing by the Director of Research.
Please address questions regarding the application of this Guide to Melissa Paciulli, Manager
of Research and Development. Other resources, such as an MS Word report template, can be
provided to help you if needed.
Please refer to the checklist on the following page prior to submitting a draft final
report to MassDOT.
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Checklist for Final Report
1.0 Content and Organization:
Report is written clearly and concisely.
All front matter is included.
All required report chapters are included.
Deviations from the above have been approved in writing by MassDOT.
2.0 Required Format:
Language used is in third person throughout.
Microsft Word 2007 or higher has been used.
Normal style has been followed for body text.
Styles have also been defined (as explained in this section) for three levels of heading,
bulleted and numbered lists, and table and figure captions.
Margins are correct.
Pagination is correct (Roman numeral vs. Arabic, continuous numbering except cover).
Tables of contents for the report, and for tables and figures, are automated and updated.
Chicago style has been followed.
All acronyms have been defined.
References and citations are consistent with TRB style, and citations have been doublechecked against Reference List.
Bulleted and numbered lists are consistent in style.
Deviations from above have been approved in writing by MassDOT.
A final spellcheck and grammar check have been done.
3.0 Section 508 Compliance:
Document layout and formatting has been checked against standards (see Section 3.21).
Tables, figures, and other objects and images have been checked against standards (see
Sections 3.22 and 3.23).
Additional information has been checked against standards (see Section 3.24).
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1.0 Content and Organization
1.1 Sections To Be Included
The content of the report body may vary, depending on the nature of the research project.
However, the final report must be organized into sections and chapters as follows:
Front Matter:
• Cover
• Technical Report Document Page
• Title Page
• Acknowledgements
• Disclaimer
• Executive Summary
• Table of Contents
• List of Tables
• List of Figures
• List of Acronyms (if required)
Body of the Report:
• 1.0 Introduction
• 2.0 Research Methodology
• 3.0 Results
• 4.0 Implementation and Technology Transfer
• 5.0 Conclusions
• 6.0 References
• 7.0 Appendices (if required)
If you feel that variance from this organization would better present your research, you
must submit a written change of format request to the Manager of Research and the
Project Champion as soon as possible.
The remaining sections in Chapter 1.0 describe the content requirements for each chapter of
the report.
The following chapters in the Guide detail the format for you to follow in presenting your
research. A Sample Research Report for further guidance is provided in the Appendix.
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1.2 Cover
See example of a Report Cover in the Sample Research Report, in the Appendix. Submit a
photo to be used, and MassDOT will create this cover page.

1.3 Technical Report Document Page and
Abstract
Completion of the Technical Report Document is self-explanatory (see Table 1, and Sample
Research Report). MassDOT will provide a Performing Organization report number (item
8) to be used. The “total number of pages” (item 21) is a count of all pages, beginning with
the Technical Report Document Page through the final appendix page.
Each final report must contain an abstract within the Technical Report Document Page. The
abstract should be 200 words or less. It should be self-contained, and it should require no
reference to the report to be understood. The abstract presents the primary objectives and
scope of the study. Describe specific techniques or methods only to the extent necessary for
comprehension. Present your findings and conclusions concisely and informatively, with
direct statements in complete sentences. Limit the use of bulleted or numbered lists, and do
not use undefined terms, acronyms, reference citations, abbreviations, or equations.
The Transportation Research International Documentation (TRID) database uses this abstract
to describe the research project.
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Table 1: Technical Report Document
1. Report No.

2. Government Accession No.

3. Recipient's Catalog No.

SPRII.**.**.*
4. Title and Subtitle

5. Report Date
6. Performing Organization Code

7. Author(s)

8. Performing Organization Report No.

UMTC-XX
9. Performing Organization Name and Address

10. Work Unit No. (TRAIS)
11. Contract or Grant No.

12. Sponsoring Agency Name and Address

13. Type of Report and Period Covered

14. Sponsoring Agency Code
15. Supplementary Notes

16. Abstract

An abstract of 200 words or less, suitable for use in computerized information storage and retrieval systems, should be
presented. The abstract will be provided to the Transportation Research Information Services (TRIS) and the National
Technical Information Service (NTIS). The abstract should use direct statements in complete sentences to describe the
work scope and principal findings.

17. Key Word

19. Security Classif. (of this report)

Form DOT F 1700.7 (8-72)

18. Distribution Statement

20. Security Classif. (of this page)

Reproduction of completed page authorized
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21. No. of Pages

22. Price

1.4 Title Page
List author name(s) and professional titles on the Title Page of the report, as shown in
Figure 2. See the Sample Research Report in the Appendix for a specific example.
Graduate student authors who have made a meaningful contribution to the writing of the final
report may be listed as co-authors on the Title Page. However, when students help with
collection of data but do not contribute in any way to the preparation of the written portion of
the final report, their data collection role would be mentioned in the Acknowledgements
section, not on the Title Page.

Figure 1: Final Report Title Page

1.5 Acknowledgements and Disclaimer
Sections
The Acknowledgements section should include the following statement, before all other text:
Prepared in cooperation with the Massachusetts Department of Transportation, Office of
Transportation Planning, and the United States Department of Transportation, Federal
Highway Administration.
Following this statement, the authors may wish to acknowledge the efforts of their research
team. Please see the Sample Research Report in the Appendix for an example.
6

The Disclaimer section should be word for word as follows:
The contents of this report reflect the views of the author(s), who is responsible for the facts
and the accuracy of the data presented herein. The contents do not necessarily reflect the
official view or policies of the Massachusetts Department of Transportation or the Federal
Highway Administration. This report does not constitute a standard, specification, or
regulation.

1.6 Executive Summary
The Executive Summary should provide a stand-alone summary of the research report. As
readers are more likely to refer to the Executive Summary than to the full report,
recommendations should be supported within the Executive Summary.
Requirements of the Executive Summary:
• Provide the primary scope and objectives of the study.
• Provide a concise synopsis of the research issue.
• Convey the significance of the research.
• Convey the main findings or results, in a concise manner.
• Provide conclusions and recommendations of the research.
For consistency, the above points should match exactly those presented later in the final
report.
This section should not contain:
• Unfamiliar terms that haven’t been defined.
• Undefined acronyms.
• Reference citations.
• Displayed equations or lists.
The length of the Executive Summary should be approximately two to five pages.
If the research report contains many acronyms, provide a List of Acronyms at the front of the
document (see Section 1.8 ).
The following paragraph should be included in the beginning of the Executive Summary,
preceding any other text:
This study of [report title], was undertaken as part of the Massachusetts Department of
Transportation Research Program. This program is funded with Federal Highway
Administration (FHWA) State Planning and Research (SPR) funds. Through this program,
applied research is conducted on topics of importance to the Commonwealth of
Massachusetts transportation agencies.
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1.7 Table of Contents and Lists of Tables
and Figures
The Table of Contents, List of Tables, and List of Figures are required chapters. All of these
must be automatically generated so they can be updated as content changes are made during
the review process, and in order to conform to Section 508 standards. See the applicable
sections in Chapter 2.0, Required Format, for instructions on how to create these.

1.8 List of Acronyms (if required)
If many acronyms are used throughout the report, create a table containing a list of all
acronyms used, with their titles spelled out in full. Otherwise, ensure that all acronyms are
spelled out at least the first time they are used in body text.

1.9 Introduction
The Introduction is meant to paint a clear and concise overview of the research. As the
opening chapter of the research report, this section should capture the attention of the reader
and provide relevant detail.
Requirements for the Introduction:
• Provide a clear and concise overview of the research issue.
• Provide the historical background of the research issue.
• Convey the research goals and objectives.
• Convey the basic approach to the project, e.g., field study, case study, experiments,
site testing, etc.
• List the main objectives of the research project and associated tasks (action steps).
• Unlike the Executive Summary, the Introduction does not include research results,
conclusions, or recommendations.
• If the research included site testing, the Introduction should include a locus map,
latitude and longitude in Massachusetts State Plane coordinates, and a detailed site
map.
The following paragraph should be included in the beginning of the Introduction, preceding
any other text:
This study of [report title] was undertaken as part of the Massachusetts Department of
Transportation Research Program. This program is funded with Federal Highway
Administration (FHWA) State Planning and Research (SPR) funds. Through this program,
applied research is conducted on topics of importance to the Commonwealth of
Massachusetts transportation agencies.
8

1.10 Research Methodology
The Research Methodology chapter is meant to provide the reader with a detailed
explanation of the methods used to conduct the research. The methods should be outlined in a
clear and concise format, using tables and figures only when they will add depth to the text.
Requirements for the Research Methodology chapter:
• Detailed explanation of the research approach.
• Methods of data collection and analysis.
• Scope and limitations of the research project.
• Overview of research methods, including literature review, experiment design, field
study/site testing detail, etc.
• Description of the materials and equipment utilized.
• Analytical procedures and evaluation methods.
• Criteria for measuring progress/success.

1.11 Results
The Results chapter is meant to highlight the outcomes of the research. This may include
trends that were recorded or unexpected outcomes. As this chapter represents the fruits of the
difficult research, care should be taken to provide a clear and inclusive picture for the reader.
Requirements of the Results chapter:
• Results of the research.
• Clear and concise picture regarding the outcomes and trends recorded.
• Tables and figures may be used to guide the reader toward important information.
o If there is very little data or a lack of variation in the data, then a table is not
necessary, as the information can be relayed in the text.
o However, if the research is complex, dense, or shows great variation, then a table
or figure may be helpful.
• Unexpected outcomes of the research.

1.12 Implementation and Technology
Transfer
The Implementation and Technology Transfer chapter will be based on the Implementation
and Technology Transfer plan, as outlined in each agreement. This section is a critical
component of the research report, as the information provided here will aid in the transfer of
this knowledge.
The Implementation and Technology Transfer chapter will include:
9

•
•
•
•
•
•

Lessons learned.
Opportunities for technology transfer.
An implementation plan for the research.
Potential institutional barriers.
Guidance for future planning, design, and deployment of research findings.
Guidance for future training associated with this research.

1.13 Conclusions
The Conclusions chapter is meant to provide a summary of the research report and should
include a more general overview of the research and the broader implications of the findings.
The Conclusions chapter will include:
• Conclusions and recommendations of the research.
• Strong connections between the evidence that has been collected and the
recommendations that are being provided.
• Discussion of the findings of the research and the broader implications of said
findings.
• Limitations of the research.
• Possibilities for future research.

1.14 References
Reference lists, unlike bibliographies, list only the sources cited in the text and are organized
in the order of citation. Bibliographies generally include all sources consulted, not just those
cited in the text, and generally are organized alphabetically. Reference lists are required for
all research reports.
The References chapter demands absolute accuracy. Because references come from a wide
variety of sources, definite rules for the identification of reference materials have been
adopted and should be carefully observed. See Chapter 2.7 concerning the required format
for references and how they must be cited in the body of the report.

1.15 Appendices (if required)
The Appendices chapter provides a space in the research report for addenda to the body of
the report. The Appendices, while offering more flexibility in terms of formatting (as they are
often protocols from other sources, etc.), should still be treated as part of the document. If the
Appendices won’t attach to the main document, please send as a separate pdf.
The Appendices will include:
10

•
•
•
•
•

Relevant data summaries, graphs, and charts not used in the report.
Lab reports.
Non-standard protocols.
Glossaries.
Any other relevant information left out of the main body of the report.

Follow the required format for Appendix headings as described in Chapter 2.0.

11

This page left blank intentionally.

12

2.0 Required Format
Prepare your final draft report using Microsoft Word. MassDOT expects that draft final
reports submitted will be complete, accurate, and fully formatted. Please thoroughly review
your report prior to submittal. Chapter 4.0 on Manuscript Submittal contains additional
information.
The Transportation Research Board (TRB) “Preparing Papers for Peer Review and
Presentation,” as well as the Chicago Manual of Style (visit
http://www.chicagomanualofstyle.org/home.html), were generally referenced to develop
these guidelines, with some differences. If you feel that variance from the format in this
Guide would better present your research, you must submit a written change of format
request to the Manager of Research and the Project Champion as soon as possible.

2.1 Manuscript Specifications
2.1.1 Length of Manuscript
Final reports will vary in length, based on the research conducted. There is no upper or lower
page limit. However, write your report as clearly and concisely as possible.
2.1.2 Software to be Used
Please make every effort to prepare your report using Microsoft Word 2007 or later versions.
Use of Microsoft Word 2003 or earlier versions frequently results in problems with
formatting and editing the final report, and with addressing Section 508 compliance.

2.2 General Style
Generally, refer to the Chicago Manual of Style (http://www.chicagomanualofstyle.org/
home.html) and Merriam Webster for style, usage, and spelling guidance. Avoid jargon and
undefined acronyms. The writing style should be appropriate for a technical document: clear,
concise, readable, and effective.
Before submittal, ensure that your entire document is written in one voice, without the use of
first-person or second-person singular or plural, such as “I,” “we,” “us,” or “you.” Often,
papers are written in stages by different authors. This can create issues with continuity and
flow of the document. Review the report carefully for consistency and continuity.
Follow the instructions in this Guide and the Sample Research Report when building your
final report. Style direction for formatting is provided throughout.
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2.3 Organization of Final Report
The final report should be organized into the following sections:
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Cover
Technical Report Document Page
Title Page
Acknowledgements
Disclaimer
Executive Summary
Table of Contents
List of Tables
List of Figures
List of Acronyms (if needed)
1.0 Introduction
2.0 Research Methodology
3.0 Results
4.0 Implementation and Technology Transfer
5.0 Conclusions
6.0 References
7.0 Appendices (if needed)

2.4 Page Setup
2.4.1 Margins
•
•
•

Left 1.25 in., Right 1.0 in.
Top 1.0 in., Bottom 1.0 in.
Header 0.5 in., Footer 0.5 in.

2.4.2 Normal Style (Font and Alignment)
•
•
•

Font should be Times New Roman.
Text in body of report should be 12 point.
Text should be left-aligned, not justified.

2.4.3 Pagination
Do not number either the Cover page or blank page that follows it. Beginning with the
Technical Report Document Page and through all front matter, number pages continuously
using lower-case Roman numerals, starting with i. At the Introduction, begin numbering with
Arabic numerals, starting with 1. Use Arabic numerals to the end of the document, including
Appendices.
14

Page numbering format:
• Insert page numbers using the Footer tab, placing them centered at the bottom of the
page.
• The front matter of the document, from the Technical Report Document Page up to
the Introduction, will have lower case Roman Numerals (i, ii, iii…).
• Start Arabic numerals (1, 2, 3…) with the Introduction (1.0), and continue through to
the end of report, including all Appendices. Use Word’s section breaks function to
change page numbering style from Roman Numeral to Arabic.
• Do not include title, author name, date, logos, etc. on the top or bottom of any page.
• The following sections should begin on a right-hand page when printed (i.e., oddnumbered page):
o Technical Report Document Page
o Title Page
o Acknowledgements and Disclaimer (these sections will be on the same page)
o Executive Summary
o Table of Contents
o List of Tables
o List of Figures
o List of Acronyms
o All Main Chapter Headings (1.0 to 7.0)
o References
o First page of each Appendix
•

Insert blank pages as necessary to ensure that these sections begin on a right-hand
page when printed. These blank pages should contain the sentence “This page left
blank intentionally.” in the center of the page (except for the blank, unnumbered page
following the Cover).

2.4.4 Widows and Orphans
•
•
•

Do not leave a single line of text at the top or bottom of a page. If necessary, move
the associated paragraph to the next page.
Do not insert a heading without text at the bottom of a page. Instead, move it to the
next page by inserting a page break.
Keep numbers or words that depend on each other for meaning on the same line by
inserting nonbreaking spaces (Control+Shift+Space).

2.4.5 Paragraphs
Begin new paragraphs flush with the left margin; do not indent. Use an extra line space
between paragraphs.
2.4.6 Headings and Subheadings
Clear and logical reading order is one of the most important parts of a successful final report.
It is useful for all readers, and is also a requirement of 508 compliant documents. For this
15

reason, all reports must have clear chapter and subchapter headings, not exceeding two
levels of subheading. For example, within Chapter 1 (1.0), there may be 1.1 and 1.1.1.
Create all of your report headings using the “styles” function in Microsoft Word. This step
allows creation of a Table of Contents that you can then automatically update as page
numbers shift during editing, and also makes the document Section 508 compliant. This
section gives instructions on how to create headings using styles. See Section 2.10 for
instructions on how to create your automated Table of Contents.
Main Chapter Headings
The following parts of the report are considered main chapters and should begin on the righthand side of the report (odd-numbered pages) when printed. Begin each main report chapter
on its own page. Insert blank pages to ensure that the chapter begins on the right-hand side of
the printed report.
• Technical Report Document Page
• Acknowledgments and Disclaimer (on the same page)
• Executive Summary
• Table of Contents
• List of Tables, List of Figures, and List of Acronyms
• All Chapter Headings (1.0 through 7.0)
• First page of each Appendix
For main headings, use the following specifications. Format your first main heading and save
its style as “MCRP Main Heading.” See example in Figure 2.
• Times New Roman, bold, 20 point.
• Aligned center, 0 in. left indent, 0 in. right indent.
• No hanging indent, single line spacing, 0 point before spacing, 24 point after spacing.

Figure 2: Example of Main Chapter Heading
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Subheading Level 1
Format your first chapter subheading and save this style as “MCRP Heading 1.” These
subheadings do not begin on a new page or print on a right-hand page. Follow these
specifications for Subheading Level 1, and see example in Figure 3:
• Times New Roman, bold, 14 point.
• Aligned left, 0 in. left indent, 2.5 in. right indent.
• No hanging indent, single line spacing, 30 point before spacing, 18 point after
spacing.
• 0.5 point dotted border under text.

Figure 3: Example of Subheading Level 1

Subheading Level 2
For Subheading Level 2, if needed, use the following specifications. Format your first use of
this subheading and then save this style as “MCRP Heading 2” in Microsoft Word. See
example of Subheading Level 2 in Figure 4.
• Times New Roman, Bold, 12 Point.
• Aligned left, 0 in. left indent, 0 in. right indent
• No hanging indent, single line spacing, 18 point before spacing, 6 point after spacing.

Figure 4: Example of Subheading Level 2
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2.5 Bulleted and Numbered Lists
Be consistent with bulleted and numbering styles throughout the document. Use one style of
numbered list and one style of bulleted list throughout the document. Only use a numbered
list if an order is implied within the list; otherwise, use a bulleted list instead.
For numbered lists, use Word’s automated numbering function to create the numbers, in
order to ensure Section 508 compliance.
When you have created your first list, save this as a style called “List Paragraph” to ensure
consistency and Section 508 compliance, and apply that style throughout.

2.6 Table Titles and Figure Captions
Create table titles and figure captions above a table or below a figure by right-clicking on the
table or figure and then selecting “Insert caption.” Please note that table and figure
headings should be no longer than five words. Also see Section 2.9 for more instructions
concerning how to insert and format tables and figures and to ensure they are 508 compliant.
For all table titles and figure captions, use the following specifications (see Figure 5):
• Title all tables and figures to identify their contents.
• Titles should be brief and concise, no more than five words. Align titles centered,
above tables and below figures.
• Use Times New Roman, Bold, 11 point.
• Use “sentence case,” capitalizing only the first word in the title, unless it’s a proper
noun..
• Do not use periods at the end of titles.
• If needed, enter any additional explanation about the table or figure, as well as source
information, in one of two ways:
o Add it as an asterisked note in Times New Roman, 10 point font, below the object
o Explain it in the body text
• Allow Microsoft Word to automatically number tables and figures. They will be
numbered 1, 2, 3, etc., with no additional numbers, periods, or dashes.
• After creating the first caption, save it as a new “style.” Name the style “TableMassDOT” and “Figure-MassDOT”; this will allow you to create a List of Tables and
List of Figures that can be automatically updated when formatting the document.

18

Figure 5: Example of table placement and title

2.7 References and Citations
Citation and reference lists demand absolute accuracy in both content and format. The rules
for the identification of references should be carefully observed. Use the TRB’s resource for
its Paper Authors for annual meetings, “Preparing Papers for Peer Review and Presentation at
the TRB Annual Meeting,” as a guide for formatting your reference list (http://www.trb.org/
AnnualMeeting/AMPaperAuthorResource.aspx).
2.7.1 Reference List
•
•
•
•
•
•
•

List all references used in the References chapter of the report, numbered in the
order in which they first appear in the report.
Do not include references that were not cited in the report; this is a reference list,
not a bibliography.
Do not repeat a reference in the Reference list or refer to it by the use of ibid, loc. cit.,
and so forth.
Check the spelling of names, initials, and dates. Give the title of the article as it was
published.
Avoid use of unpublished references wherever possible.
Print the names of journals, proceedings, bulletins, and books in italics; print the titles
of papers in Roman; capitalize using heading style.
Do not set off titles of articles in quotation marks.

2.7.2 Citations
•

Cite a reference in body text by inserting the reference number at the end of the
applicable sentence, using an Arabic numeral in italics and parentheses (see examples
in Figure 6 and the Sample Research Report in the Appendix). For multiple
references applying to the same sentence, list them in the order they are cited in the
text. Note that this citation style differs from that of Chicago style.
19

•

When the report is complete, do a final check to ensure that all citations agree with
text and that all numbered citations agree with the reference list. Remember that text
revisions may require renumbering of citations or other reference changes, and vice
versa.

See examples of how to insert citations (Figure 6), and how to format typical references per
TRB style (Table 2).

Figure 6: Example of citations within body
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Table 2: Guide for references*
Type of Reference
Periodical

Example
Sansalone, M., J. M. Lin, and W. B. Streett. Determining the Depths of
Surface-Opening Cracks Using Impact-Generated Stress Waves and Timeof-Flight Techniques. ACI Materials Journal, Vol. 95, No. 2, 1998, pp.
168–177.

Proceedings

Leadabrand, J. A., and L. T. Norling. An Example of Soil-Cement
Treatment. 2nd Int. Conf. on Soil Mech. and Found. Eng., Rotterdam, The
Netherlands, Proceedings Vol. 4, 1956, pp. 62–84.

Unpublished Papers

Corbett, J. J. Toward Environmental Stewardship: Charting the Course for
Marine Transportation. Presented at 83rd Annual Meeting of the
Transportation Research Board, Washington, D.C., 2004.

Abstract

Directional Signing on Metropolitan Freeways. Automobile Club of
Southern California, Los Angeles, CA, July 3, 1963, 11 pp. Highway
Research Abstracts, Vol. 34, No. 6, June 1964, p. 10.

Corporate author

Automotive Safety Foundation, Traffic Control and Roadway Elements:
Their Relationship to Highway Safety, Washington, D.C., 1963.

Government Report

Von Quintus, H. L., and A. L. Simpson. Documentation of the
Backcalculation of Layer Parameters for LTPP Test Sections. Publication
FHWA-RD-01-113. FHWA, U.S. Department of Transportation, 2002.

TRB Publication

Dewan, S. A., and R. E. Smith. Creating Asset Management Reports from
a Local Agency Pavement Management System. In Transportation
Research Record: Journal of the Transportation Research Board, No.
1853, Transportation Research Board of the National Academies,
Washington, D.C., 2003, pp. 13–20.

Book

Newland, D. E. Random Vibrations: Spectral and Wavelet Analysis. John
Wiley & Sons, Inc., New York, 1998.

Part of book only

Newland, D. E. [name of chapter or section]. In Random Vibrations:
Spectral and Wavelet Analysis. John Wiley & Sons, Inc., New York, 1998,
pp. [xx–yy].

Highway Dept. report

New York Dept. of Public Works. Asbestos Admixture in Asphalt
Concrete. Physical Research Proj. No. 11. Engineering Research Series,
Research Rept. RR60-5, Dec. 1960.

Congressional
document

U.S. Cong., 77th 2d SESS., Committee on Roads, Proposed Highway to
Alaska. Hearings … on H.R. 3095, a bill authorizing the construction of a
highway to Alaska, Feb. 4, 5, and 6, 1942. U.S. Govt. Print. Office,
Washington, D.C., 1942, 151 pp.
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Type of Reference

Example

Websites and
Electronic Sources

References to websites should include corporate or personal authors, title of
document, date of document (if available), web address (complete URL),
and date accessed by the author. For example, a periodical article:
Nemmers, C. Transportation Asset Management. Public Roads Magazine,
July 1997. www.tfhrc.gov/pubrds/july97/tam.htm. Accessed Jan. 13, 2002.

CD-ROM (same
format as printed
version, but add CDROM)

Solaimanian, M., J. Harvey, M. Tahmoressi, and V. Tandon. Test Methods
to Predict Moisture Sensitivity of Hot-Mix Asphalt Pavements. In Moisture
Sensitivity of Asphalt Pavements. CD-ROM. Transportation Research
Board of the National Academies, Washington, D.C., 2004, pp. 77–110.

Program Manuals,
Tapes or other
documentation for
models

MINITAB User’s Guide 2: Data Analysis and Quality Tools. Minitab, State
College, PA, 2000, pp. 27–52.

*Source: TRB, Preparing Papers for Peer Review and Presentation at the TRB Annual Meeting, updated June
14, 2016, http://www.trb.org/AnnualMeeting/AMPaperAuthorResource.aspx.
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2.8 Metrication
Use the same abbreviations for measurements throughout the report. Refer to Sections 10.52
and 10.53 in the Chicago Manual of Style (http://www.chicagomanualofstyle.org
/16/ch10/ch10_sec052.html) for instructions and a list of the most common technical and
statistical abbreviations.
2.8.1 Equations
Create all equations as part of the text. Alternatively, submit them as embedded images
within the text. Explain and identify each variable and constant in the equation. Cite the
source for equations as well. Be sure that all symbols, Greek letters, and mathematical signs
are exact, defined, and absolutely unambiguous; for example, carefully distinguish the
following:
• All capital and lowercase letters
• Capital O (“oh”), lowercase o (“oh”), and 0 (zero)
• Lowercase l (“el”) and number 1 (one)
• Letter X, Greek chi (χ), and multiplication sign ×
• Prime ´, apostrophe ’, and superscript one 1
• English and Greek letters such as:
o B and beta (β), upper- or lowercase k and kappa (κ),
o n and eta (η), v and nu (ν),
o u and upsilon (υ), u and mu (μ), and
o Upper- or lowercase p and rho (ρ), and w and lowercase omega (ω).
Follow these instructions regarding equations:
• Show the relative positions in equations and formulas of all subscripts, superscripts,
fractions, and operators.
• Give units of measure common to the field of research reported.
• Most projects will involve the use of the U.S. Standard units of measure in the
conduct of the research and the reporting of research results.
2.8.2 Abbreviations, Acronyms, and Symbols
Follow these instructions:
• Fully define abbreviations, acronyms, and symbols by writing out the full names,
followed by the abbreviations in parentheses the first time they are used in the report
(see examples in Figure 7).
• Thereafter, use only the abbreviated term, without parentheses.
• If many acronyms are used throughout the report, create a List of Acronyms in the
front matter.
• Because the Executive Summary may be used as a stand-alone document, acronyms
defined in this section should be defined again in the body of the report.
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First mention:
spell out and put
acronym in
parentheses

First mention:
spell out and put
acronym in
parentheses

All following
mentions of
MassDOT: use
acronym only

Figure 7: Examples of acronyms

2.9 Tables and Figures
The purpose of tables and figures is to relay supplemental, not duplicate, information in a
clear format. See Section 2.6 for detailed steps on how to create table and figure captions.
2.9.1 Section 508 Compliance
All tables and figures must comply with Section 508 standards by the use of “alt text.”
Right-click the table or figure to navigate to “Properties.” Within Properties is the “Alt Text”
section, which provides the reader with additional information about the table or figure. The
“Alt Text” section must be completed for each table and figure; otherwise, the document
is not 508 compliant. Entering the title of the table or figure is the minimum action required,
but more information should be included if further clarity is necessary.
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2.9.2 Tables
Tables present short descriptions or numerical listings that are more clearly presented in
tabular rather than bulleted or narrative format. They should be self-explanatory and should
supplement, not duplicate, information given in the body of the report.
Follow these instructions regarding tables (see Figure 8 for example):
• Provide tables embedded in the text of the document, by using the “Insert Table”
function in Word. Do not break a table across two pages; insert a page break to keep
the table on one page. Large tables of two or more pages should be in an appendix.
• Allow Microsoft Word to number all tables consecutively with Arabic numerals,
using the “insert caption” option (see Section 2.6).
• Title all tables to identify their contents, keeping the title to no more than five words.
Center the title above the table and use sentence case, no period (see Section 2.6).
• Use a dash (-) for empty cells in a table, indicating its meaning in a footnote (e.g.,
missing data, data not available or not applicable).
• Check the accuracy of all totals included in tables.
• Refer to each table by number at the appropriate places in the text (e.g., “Table 1
shows a list of ….”); do not hyperlink the text reference to the actual table.
• Tables should immediately follow their first textual reference, appearing on the same
page wherever possible.
• Use tables of comparable size and scale when they are intended to be compared.

Figure 8: Example of table placement and title

2.9.3 Figures
Figures are photographs, drawings, charts, graphs, and other objects that supplement the
body of the final report. They should convey information clearly and completely. Lettering
and numerals must be of adequate size and clarity to be easily read.
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To ensure Section 508 compliance, figures should be free of all “floating objects.” For
example, if arrows or text boxes are used, those objects should be “grouped” within the main
figure as a single object.
Follow these instructions for figures:
• Provide figures (including photographs) embedded within the text of the document.
• Figures must use the “in line with text” text wrapping style.
• Allow Microsoft Word to number all figures consecutively with Arabic numerals,
using the “Insert Caption” option (see also Section 2.6).
• Caption all figures to identify their contents, limiting caption to no more than five
words. Center the caption below the figure, using 11 point font and no period.
• Cite the outside source of the figure if applicable, either in the body text or as a
footnote below the figure but above the caption (see also Section 2.6).
• Use figures of comparable size and scale when they are intended to be compared.
• Use abbreviations, numerals, and capitalization consistent with body text.
• Figures should immediately follow their first textual reference, appearing on the same
page wherever possible.

Figure 9: Example of figure placement and caption

2.10 Creating an Automated Table of
Contents
In order to comply with Section 508 regulations, all headings must be created using “styles”
in Microsoft Word. Heading styles create an organized and logical reading order for all
readers, and are particularly critical for people using screen reader technology. This step will
also permit the creation of an automatically generated Table of Contents (TOC), which can
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can be automatically updated to reflect correct page numbers and section headings as the
final report is edited.
To create a TOC that can be automatically updated, assign a “style” to each heading that is
meant to be represented in the TOC (see Section 2.4.6). Assign a style to the following
headings:
• Technical Report Document Page
• Title Page
• Acknowledgements and Disclaimer (Assign both a style so they are represented
separately in the TOC)
• Executive Summary
• Table of Contents
• All Chapter Headings and up to two levels of subheadings (e.g., 1.1, 1.1.1)
• References
• Appendices
To create a new style that can be used for the TOC, begin by formatting all headings. Once
the headings have been formatted, begin creating “styles” for each:
• Highlight the heading and then right-click the highlighted heading.
• Scroll down to “Styles” and choose “Save selection as a new style.”
• Name the style using the conventions in Section 2.4.6.
To create the automated TOC, follow these steps:
• Place your cursor on the page where you want to insert the TOC.
• Select References > Table of Contents > Insert Table of Contents:
o Make sure the boxes for “Show Page numbers” and “Right-align pages” are
selected.
o Under Tab Leader, select a dotted line (…..).
o Under Formats, select “From Template” from the drop-down menu.
o Deselect the box that says “Use hyperlinks instead of page numbers.”
o Under Options, select the TOC levels that you will be using. To do this, first
select “Reset” to remove any existing choices. Then find the styles you created for
your headings, and enter 1, 2, and 3 under the Main Heading and subheadings
respectively. Make sure these are the only styles selected, or unwanted text will
appear in your TOC.
o Under Table of Contents > Modify, select TOC 1 and ensure that Times New
Roman 12 point is the font to be used; select Modify > Style and name the style
MCRP TOC. This saves your TOC style and adds it to your quick style menu.
• Select OK when ready.
• To update the TOC when the report is done, click the TOC and select References >
Update Table > Update entire table.
An example of a TOC is shown in the Sample Research Report in the Appendix.
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2.11 List of Tables and List of Figures
The process for creating the List of Tables and the List of Figures is similar to that of the
TOC. These lists provide readers with the titles of all tables and figures within the report.
Use the Insert Table of Figures function in Word to create lists of tables and figures. This
step will ensure that after the report is edited, the List of Tables and List of Figures can be
automatically updated during the report editing process to reflect the correct page numbers of
each table and figure.
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3.0 Section 508 Compliance
3.1 Introduction
Federal Section 508 standards make technology accessible for people with mobility,
auditory, and visual disabilities. As a state agency, MassDOT must comply with these
standards for all information made available in electronic form, in order to provide access to
every citizen of the Commonwealth. Therefore, all final reports published by MassDOT
must comply with Section 508 standards.
It is your responsibility to ensure that your draft final report is fully accessible prior to
submittal. Note that it is much easier to create a Section 508 compliant document if you start
incorporating the requirements from the beginning, rather than when the final report is fully
prepared.
Section 3.2 provides summary guidance for ensuring that your Microsoft Word report meets
accessibility standards. For each standard, see applicable sections of Chapter 2.0 for more
detail on how to meet that standard.
Microsoft Word versions 2010 and later have an “accessibility checker” function that can be
found under File > Information > Check for Issues > Check Accessibility. Further guidance
on accessibility is provided by Microsoft at Microsoft.com Online Accessibility Center,
https://www.microsoft.com/enable/.
For more information about the federal Section 508 standards, visit the GSA’s Section 508
website at https://www.section508.gov/ or the United States Access Board website at
https://www.access-board.gov/.

3.2 Section 508 Standards
3.21 Document Layout and Formatting
•
•
•
•
•
•

The entire document is formatted using Style elements (e.g., Heading 1, Heading 2,
Normal, List Paragraph).
The document does not use flashing/flickering text or animated text/images.
Word’s automatic page numbering function is used (as opposed to manually typed
page numbers).
Any footnotes, if applicable, have been created through Word Footnote linking.
The use of color is avoided wherever possible. If it is needed, it is accompanied by
alternative descriptions.
Automated bullet or numbering styles have been used (as opposed to manually added
characters.
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•
•
•
•
•

All tracked changes have been accepted or rejected, and the Track Changes function
has been turned off.
Comments been removed and formatting marks have been turned off.
Document has been reviewed in Print Preview for a final visual check.
All URLs contain the correct hyperlink and display the fully qualified URL with the
“http” prefix (e.g., http://www.section508.gov).
All URLs have been checked to ensure they lead to the correct web destination.

3.22 Document Images (Including Figures)
•
•
•
•
•
•
•

All images, grouped images, and non-text elements that convey information have
alternative text (Alt Text) descriptions. For figures, this includes at minimum the
figure caption.
Complex images (charts and graphs) are accompanied by descriptive body text
immediately preceding the image, and followed by figure captions.
The document is free of background images and watermarks.
The image text-wrapping style “In Line with Text” is used for all images.
Multiple associated images on the same page (e.g., boxes in an organizational chart)
are “grouped” as one object.
All multilayered objects have been “flattened” into one image and use one Alternative
Text (Alt Tag) for the image.
The document is free of text boxes used for simple graphics.

3.23 Document Tables
•
•
•
•
•
•

Tables have been inserted to create a tabular structure (rather than use of tabs or
spaces).
All tables have a logical reading order from left to right, top to bottom.
Data tables have the entire first row designated as a “Header Row” in Table
Properties.
All tables are free of “merged cells.”
All tables are described in body text, and titled and numbered using a defined table
style.
In Table Properties, “Allow row to break across pages” is unchecked.

3.24 Additional Standards
•
•
•
•
•

The document file name reflects the content of the document; e.g., “RAP final draft
report 6-1-16.”
The document utilizes Times New Roman font.
The Document Properties (Subject, Author, Title, Keywords, and Language) are
accurately completed.
The Tables of Contents for the report and for figures and tables are automatically
generated and were all created using TOC styles in Word.
A separate accessible version of a portion of the report has been provided when there
is no other way to make the content accessible (e.g., organizational chart).
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4.0 Manuscript Submittal
All final reports must be submitted to MassDOT in final draft form a minimum of three
months (90 days) prior to the end of your contract.
Submit the document as a final report, even though edits and changes may be made following
submittal. All efforts should be made by your research team to provide a document with the
highest possible quality and accuracy.
MassDOT reserves the right to withhold final payment for the research if the final report has
not been received by the due date, or if questions arise regarding quality or accuracy.
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5.0 Appendix: Sample Research Report
The following pages are excerpts from two sample research reports to illustrate the
guidelines in Chapters 1 through 3.
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Executive Summary
This study of the Evaluation of Portable Road Weather Information Systems was undertaken
as part of the Massachusetts Department of Transportation (MassDOT) Research Program.
This program is funded with Federal Highway Administration (FHWA) State Planning and
Research (SPR) funds. Through this program, applied research is conducted on topics of
importance to the Commonwealth of Massachusetts transportation agencies.
Effective highway winter maintenance programs, specifically snow and ice operations,
depend on timely and accurate information to make good decisions relative to the placement
of anti-icing and deicing chemicals. Weather indicators, such as pavement temperature, air
temperature, precipitation type and intensity, and other variables, are used in the decision
process. Currently, the Commonwealth of Massachusetts has invested in a series of
permanently placed road and weather information systems (RWISs) throughout the state.
These 27 RWIS stations have been strategically placed to cover the interstate highway
system. These stations are considered vital to snow and ice operations. With increased
sensitivity to environmental concerns, many other areas in the state are without monitoring
capabilities. These permanent RWIS sites require power and communication cables at their
sites.
The purpose of this project was to evaluate portable (e.g., trailer-based) RWISs to determine
their suitability for use in Massachusetts. RWISs collect information such as pavement
temperature, air temperature, precipitation type and intensity, and other variables and make
them available to users via standard web browsers. In the early stages of the project, an effort
was made to identify portable, commercially available RWIS technologies designed to
capture and analyze weather data to help determine the appropriate application of sodium
chloride, magnesium chloride, and any other deicers used in winter operations. This effort
involved a complete literature survey of portable RWIS applications used by other state
DOTs.
Following a full literature search, the development of two fully functional prototype RWISs
based on weather sensing technology from two different companies (Vaisala, Inc. and High
Sierra Corporation) commenced. One system was constructed using sensors from Vaisala,
while the other system was constructed using sensors from High Sierra. Following initial data
analysis and comparison, the RWISs were moved to roadsides in the Commonwealth for an
extended test under winter driving conditions. As part of the project, the results of the field
tests in terms of portable RWIS reliability, accuracy, and cost were assessed. Subsequently,
three additional Vaisala-based RWISs were constructed and delivered to MassDOT for
roadside use.
As a result of project research activities, the state of the art in portable RWIS technology has
been assessed and a fleet of portable RWISs has been created for MassDOT use. These
systems provide an understanding of weather indicators used in the winter maintenance/snow
and ice decision process. Data collected from the RWISs have the potential to assist
MassDOT in making decisions to apply sodium chloride, magnesium chloride, and any other
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deicers used in winter operations, which, in turn, help achieve broader safety, fiscal, and
sustainability goals.
In conclusion, the project team’s effort to build practical, easy-to-use, and accurate portable
RWIS units has resulted in five deployable systems that are highly accurate. The systems
have been tested on roadways for an extended period of time (nearly 12 months) to determine
their long-term effectiveness. Future work could involve increasing the portable RWIS fleet
size beyond five and examining new energy and communication alternatives for the portable
RWISs. It is the team’s belief that portable RWISs can serve a vital role in providing
roadway information for roads in isolated locations in the Commonwealth. Only cellular
communication capabilities are required in the deployed location to transfer collected data.
The availability of portable RWIS information can assist MassDOT in deploying road
maintenance teams in a more efficient and cost-effective manner.
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1.0 Introduction
This study of the Evaluation of Portable Road Weather Information Systems was undertaken
as part of the Massachusetts Department of Transportation (MassDOT) Research Program.
This program is funded with Federal Highway Administration (FHWA) State Planning and
Research (SPR) funds. Through this program, applied research is conducted on topics of
importance to the Commonwealth of Massachusetts transportation agencies.
Weather conditions have a significant impact on road safety as well as roadway and highway
maintenance operations. Costs associated with winter road maintenance are very high.
Winter road maintenance alone accounts for about 20% of state DOT maintenance budgets
(1). State and local transportation agencies spend more than $2.5 billion each year on snow
and ice control operations, and more than $5 billion to repair weather-damaged roadway
infrastructure (1). Snow and ice control techniques involve the application of millions of tons
of salt to road surfaces each year. The usage of salt causes corrosion, affects vegetation, and
has detrimental effects on the environment (2). It is desirable for transportation agencies to
find sustainable and cost-effective techniques for better roadway maintenance throughout the
year, especially during winter months. Transportation agencies nationally and internationally
are working on employing such techniques to improve operations related to road
management, road safety, and emergency management. Real-time weather information also
increases the preparedness of travelers for driving in inclement weather conditions.
Road weather information systems (RWISs) play a significant role in providing weather and
surface conditions to transportation agencies to monitor weather events. Using this
information, roadway operators can efficiently plan road operations, reduce chemical, sand,
and salt usage, and provide a better level of service by using anti-icing practices. A RWIS
consists of pavement sensors and meteorological sensors to determine road condition and
weather events. The weather and pavement condition data collected by the weather sensors is
typically processed using sophisticated technology in the RWIS and sent on a network for
weather forecasting and pavement condition monitoring. Traditionally, most RWISs have
been employed in the field as permanent fixtures. In contrast, a portable RWIS consists of
trailer-mounted equipment that can be strategically relocated to different monitoring sites.

1.1 Problem Statement
Weather forecasting and roadway condition monitoring are of paramount importance for
roadway safety and operational decision making. These actions require collection of
accurate, real-time atmospheric data. Both current and historic atmospheric data greatly
affect the decision-making processes of weather forecasting, road maintenance, construction
projects, rescue operations, and the installation of future permanent RWISs at planned sites.
The accuracy of the data collected by the weather sensors and the placement of these sensors
are critical issues. Pertinent weather information can either be directly obtained or
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extrapolated to a central location by a permanent RWIS. However, there are concerns that
make permanent fixtures prohibitive. These concerns include cost, accessibility to sites, site
terrain, and permitting issues. Under these circumstances, portable RWISs are an attractive
solution to transportation agencies due to their mobility and ease of relocation. Portable
RWISs are cost-effective systems and can be used to monitor specific weather conditions for
a specific duration at the site of deployment.
This research project involves development of multiple portable RWISs to be used by
MassDOT. These systems have the potential to assist MassDOT in making decisions to apply
sodium chloride, magnesium chloride, and other deicers used in winter operations. The
systems should help achieve broader safety, fiscal, and sustainability goals. The project
involves deploying trailer-based RWIS systems in the field for monitoring weather data.
These systems are tested for accuracy and feasibility. Weather data is visible on vendor
websites. A full literature survey of the state of the art in RWIS usage and portable RWIS
technology is also provided.

1.2 Research Objectives
The following goals have been achieved in the completion of this project:
•
•
•

•

•
•

Examination of the state of the art in RWIS usage in both domestic and international
environments.
Evaluation of best practices in the existing use of RWIS equipment.
Identification of portable, commercially available RWIS technologies designed to
capture and analyze weather data and pavement data. This action involves selection
and evaluation of sensors that are suitable for the portable RWIS. Non-invasive
pavement sensors are typically suitable for a portable weather station.
Development of two portable RWIS prototypes consisting of weather-sensing
equipment procured from two different manufacturers, and identification of issues
involved in building and using these systems. The systems are contrasted for their
usability, accuracy, and maintenance.
Analysis of the results of field tests of the two prototypes. The results obtained from
the prototype RWISs are compared and documented.
Construction of three additional portable RWISs for delivery to MassDOT.

1.3 Report Outline
The remainder of this report is organized as follows. Chapter 2 reviews the state-of-the-art in
worldwide RWIS use, with a specific focus on portable RWISs. Chapter 3 describes the
equipment used to build the five portable RWISs developed for this project. Each weather
sensor is described in detail along with a discussion of trailer requirements. A comparative
analysis of results obtained from the systems and results collected from a stationary weather
system is provided. In Chapter 4, recommendations for further use of the portable RWIS and
2

the development of additional systems are provided. Chapter 5 provides conclusions for this
project.

3
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Fixed Automated Spray Technology. Several domestic departments of transportation
(34)(35) have explored the use of fixed automated spray technology (FAST) in conjunction
with RWISs. These systems either automatically enable the deployment of anti-icing
chemicals or enable their application after interpretation of RWIS data by a human operator.
A recent study from North Dakota determined that an automatically enabled system is 95%
reliable (34). Pavement condition and temperature values are read from environmental
sensors (see example of Buxton Bridge in Figure 2.7), and a computer algorithm can then
trigger spraying. A significant reduction in motor accidents was recorded after the
installation of the system on two bridges in 2002. The specific algorithm parameters can be
triggered using the Vaisala ScanWeb interface. A second study (35) determined that the use
of FAST can be cost beneficial if used with supporting RWISs. According to the report,
proactive treatment is best performed with automated systems that enable spraying after the
evaluation of road surface condition. Experiments with calcium chloride applied at a rate of 8
gallons per use were particularly effective. Nebraska has a similar FAST deployment on a
bridge that is part of an interstate highway (36). An RWIS at the location collects air and
surface temperature, precipitation, dew and freezing points, and wind speed and direction. A
fixed automated spray system that uses a deicing chemical is then deployed under likely icing
conditions. It is not clear if the spraying is triggered automatically or manually.

Figure 2.7: I-29 Buxton Bridge FAST system components
Load Restrictions for Roadways. RWIS data has also been used to develop a set of load
restrictions on roads for trucks and other vehicles at different times of the year (37). RWIS
data is used to evaluate the amount of frost on pavement under various climate conditions.
An evaluation of this data and a series of physical measurements determined a correlation
between these RWIS parameters and measured frost depth. This information was then used to
estimate the impact of thawing to help estimate load restrictions on trucks and other vehicles
14
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Table 2.1: Summary of documented portable RWISs
Label Location

Company Sponsor/
Commun. Power
Standard

Sensors

NTCIP

unclear

Traffic
cabinet

Pavement
temp.,
precipitation,
road surface

NTCIP

Ethernet

Traffic
Cabinet

Water level,
flood data

Ethernet

Traffic
Cabinet

Flood, wind,
road surface
status, rain
gauge

P1

Kansas/
Colorado

High
Sierra
5721

P2

Texas

High
Sierra
5470

P3

High
Manhattan,
Sierra
Kansas
5470

NTCIP

Aurora/
Clarus

Cellular

Solar/
battery

n/a

n/a

n/a

Wind, air,
and surface
temp., rain,
pressure
n/a
Wind, temp.,
rain,
humidity,
pressure

Cost per
unit
$2,800,
not
including
traffic
cabinet
cost
$28,800
total. 5470
and
software
costs
$12,150
$28,800
total. 5470
and
software
costs
$12,150

P4

Iowa

Vaisala
MAWS/
WXT520

P5

Missouri

Vaisala

P6

Utah

Vaisala/
n/a
Campbell

Cellular

Solar/
battery

Solar/
battery

Camera/flow
detector

$18,000
(not
including
trailer)

Solar/
battery

Undefined
weather

n/a

P7

Nevada

n/a

n/a

Cellular/
WIFI

P8

Florida

n/a

n/a

Radio

$3,000
$21,000
$14,000

Several commercial offerings have served as the basis of portable RWIS installations that
have been deployed by transportation departments.
Systems based on the High Sierra 5721. This road sensor station (54) is a NTCIPcompliant system used to warn of icing conditions on roadways. As seen in Figure 2.9, the
system contains a signal processing unit, a road surface wet/dry/ice sensor, and an optional
embedded road temperature sensor. Power and communications capabilities are obtained
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3.0 Methodology
This chapter first provides an overview of the SPFs and the safety modeling procedures for
urban and suburban arterial intersections in the 2010 HSM. Such an overview makes this
report self-contained and helps readers understand the discussions in Chapters 4 through 7.
Since the HSM safety predictive models urban and suburban arterial intersections are all
based on Negative Binomial regression, this chapter also includes a summary of the Negative
Binomial regression model.

3.1. SPFs for Urban and Suburban Arterial
Intersections in the HSM
The Highway Safety Manual (HSM) was initially published by AASHTO in 2010. It includes
a series of methods for predicting crash frequencies for different transportation facilities. The
method for urban or suburban arterial intersections is given in Eqs. (1) and (2):
𝑁𝑁𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝_𝑖𝑖𝑖𝑖𝑖𝑖 = 𝐶𝐶𝑖𝑖 × �𝑁𝑁𝑏𝑏𝑏𝑏 + 𝑁𝑁𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝 + 𝑁𝑁𝑏𝑏𝑏𝑏𝑏𝑏𝑏𝑏𝑏𝑏 �
𝑁𝑁𝑏𝑏𝑏𝑏 = 𝑁𝑁𝑠𝑠𝑠𝑠𝑠𝑠_𝑖𝑖𝑖𝑖𝑖𝑖 × (𝐶𝐶𝐶𝐶𝐶𝐶1𝑖𝑖 × 𝐶𝐶𝐶𝐶𝐶𝐶2𝑖𝑖 × ⋯ × 𝐶𝐶𝐶𝐶𝐶𝐶6𝑖𝑖 )

where,
𝑁𝑁𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝_𝑖𝑖𝑖𝑖𝑖𝑖 = final predicted average crash frequency of an intersection for a
selected year;
𝑁𝑁𝑏𝑏𝑏𝑏 = predicted average crash frequency of an intersection (excluding vehiclepedestrian and vehicle-bicycle collisions);
𝑁𝑁𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝 = predicted average crash frequency of vehicle-pedestrian collisions;
𝑁𝑁𝑏𝑏𝑏𝑏𝑏𝑏𝑏𝑏𝑏𝑏 = predicted average crash frequency of vehicle-bicycle collisions;
𝑁𝑁𝑠𝑠𝑠𝑠𝑠𝑠_𝑖𝑖𝑖𝑖𝑖𝑖 = predicted average crash frequency of an intersection (excluding vehiclepedestrian and vehicle-bicycle collisions) satisfying the base conditions defined
in the HSM;
𝐶𝐶𝐶𝐶𝐶𝐶1𝑖𝑖 , ⋯ , 𝐶𝐶𝐶𝐶𝐶𝐶6𝑖𝑖 = intersection crash modification factors; and
𝐶𝐶𝑖𝑖 = calibration factor for use in a particular geographical area.

𝑁𝑁𝑠𝑠𝑠𝑠𝑠𝑠_𝑖𝑖𝑖𝑖𝑖𝑖 in Eq. (2) is often referred to as the Safety Performance Function (SPF). In this
particular case, this SPF predicts the average crash frequency involving only vehicles for an
intersection under the base conditions defined in the HSM. To account for intersections that
do not satisfy the base conditions, a set of CMFs is provided in the HSM. As shown in Eq.
(2), the original average crash frequency, 𝑁𝑁𝑠𝑠𝑠𝑠𝑠𝑠_𝑖𝑖𝑖𝑖𝑖𝑖 , is multiplied by these CMFs to adjust for
those non-base conditions. In the 2010 HSM, 𝑁𝑁𝑠𝑠𝑠𝑠𝑠𝑠_𝑖𝑖𝑖𝑖𝑖𝑖 is separated into 𝑁𝑁𝑏𝑏𝑏𝑏𝑏𝑏𝑏𝑏 and 𝑁𝑁𝑏𝑏𝑏𝑏𝑏𝑏𝑏𝑏 as
shown in Eq. (3), and they are further described in Eq. (4). Two different sets of SPFs are
provided for 𝑁𝑁𝑏𝑏𝑏𝑏𝑏𝑏𝑏𝑏 and 𝑁𝑁𝑏𝑏𝑏𝑏𝑏𝑏𝑏𝑏 in the HSM, respectively (1). Each set consists of SPFs for
3ST, 3SG, 4ST, and 4SG intersections.
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(1)
(2)

